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 În laboratoarele trecute, vi s-au prezentat fazele de planificare:construirea unui proiect , în 
care intră activitatile, adăugarea de resurse, precum şi trecerea în jur a lucrurilor, astfel încât resursele 
atribuite nu intra în conflict unele cu altele rezultând astfel activitati ce au relaŃii reciproce. AŃi folosit 
unele detalii cum ar fi formatarea textului şi aspectul de apariŃie al activitatilor. 
 Monitorizarea este procesul de comparare a ceea ce se întâmplă de fapt în timpul 
proiectului dumneavoastră şi estimările presupuse că se vor întâmpla în proiect. Pentru a urmări, aveŃi 
nevoie de o imagine generală a proiectului in momentul când planificarea lui a luat sfârşit; acest 
moment este numit linie de bază. Dar de asemenea trebuie să înŃelegeŃi ce paşi sunt implicaŃi în 
monitorizare şi cum să stabiliŃi proceduri eficiente de a manevra aceşti paşi.  
Trasătură nouă: Cu Project 2003 ai posibilitatea să reŃii 11 linii de bază pentru fiecare proiect în parte. 
 

1. ÎnŃelegerea principiilor monitorizării 
 
Un plan bun este doar jumătate din toată munca. Cheia constă în cum să execuŃi acel plan. Imaginează-
Ńi că eşti un fel de fundaş în jocul de fotbal. Dacă alergi înainte până la capătul terenului, fară să eviŃi 
adversarii care iŃi ies în cale, nu ai să ajungi foarte departe.Monitorizarea proiectului este similară.
  
 Dacă nu te abaŃi şi nu faci ajustări pentru modificarea costurilor şi a sincronizării, lucruri 
care sunt practic inevitabile, în orice efort uman , atunci jocul nu va fi perfect. Managementul 
proiectelor software sporeşte foarte mult capacitatea de a vedea rapid problemele şi de a revizui planul, 
pentru a minimiza orice daune.Proiectul vă permite să comparaŃi ceea ce te-ai gândit (la ceea ce se va 
întâmpla de fapt) şi ceea ce se întâmplă pe parcursul proiectului. 
 
1.1 Estimările faŃă de situaŃia actuală a proiectului 
 
Planul pe care îl construieşti este o estimare a ceea ce poate să apară. Este cel mai bine să ghiciŃi cât de 
mult pot dura activitatile,ca de exemplu:cum o activitate poate să afecteze o alta activitate, cât de multe 
resurse aveŃi nevoie pentru a finaliza munca şi ce costuri vă aşteptaŃi să suporte proiectul;Managerii de 
proiect cu experientă păstrează bine estimările lor pentru a deveni manageri mai buni. Prin compararea 
acestor două seturi de date, la sfârşitul estimărilor puteŃi să utilizaŃi această informaŃie pentru a vă face 
următorul plan mai realist. PuteŃi folosi, de asemenea, date cu privire la costurile reale şi timp pentru a 
efectua schimbări în strategia dvs, care sunt necesare pentru a te menŃine pe poziŃia de monitorizare şi 



de a îndeplini obiectivele curente ale proiectului. 
 Monitorizarea în cadrul proiectului constă în specificarea informaŃiilor actuale cum ar 
fi:data de start a proiectului,data terminării proiectului şi durata actuală a activitatii. Se introduce deci 
timpul real de muncă a resurselor şi costurile reale suportate de aceştia. Când introduceŃi informaŃii 
actuale, proiectul vă arată programul revizuit specificând faptul ca programul dumneavoastră este pe 
cale de a nu se comporta aşa cum era proiectat iniŃial. 
 
1.2 Cât de mult aŃi realizat? 
 
Cum am descris în capitolul 12 se păstrează evidenta unei activitati prin introducerea estimativă a unui 
procent pentru o activitate terminata, timpul real necesar resurselor ori costurile reale care intervin 
(cum ar fi taxele plătite sau închirieri de echipamente) sau prin introducerea numărului de ore de lucru 
pe perioade de timp. Estimarea unei sarcine nu este o ştiinŃă exactă, aşa cum persoane diferite folosesc 
metode diferite. 
 Cu ceva concret, cum ar fi o clădire în construcŃie, poŃi să te uiŃi la clădirea iniŃială şi de a 
estima destul de precis cât de departe a progresat proiectul.Cele mai multe proiecte nu sunt chiar atât de 
simple, in fine.Cum estimaŃi cât de departe vă aflaŃi în mai multe sarcini de creaŃie, cum ar fi venind cu 
un concept de publicitate?PoŃi să stai în şedinŃe pentru o perioadă de cinci săptămâni fară a găsi 
conceptul corect.Proiectul dvs este 50 de procente terminat? Finalizarea este greu de măsurat pe de altă 
parte, de exemplu dacă aŃi lucrat la proiecte similare ,probabil în ultimul proiect, veniŃi având conceptul 
perfect încă din prima şedintă. Nu cădeŃi în capcana de a folosi banii sau timpul petrecut ca unitate de 
măsură.Este (din păcate) uşor de a cheltui 10000 dolari pe o activitate care este estimată la 8,000 dolari 
şi având încă 25 la sută, până la finalizare. Probabil va trebui să utilizezi aceleaşi instincte care te pun 
în sarcina de a prezenta proiectul,în sensul de estimare a progreselor sarcinilor individuale. Sugestie: 
Dacă proiectul are predări individuale pe care le puteŃi urmări, documenteaza-le şi utilizează în mod 
periodic, atunci când faci estimari. 
 De obicei, managerii de proiect urmăresc activitatea în mod regulat, cum ar fi o data pe 
săptămâna sau din două în două săptămâni. Această monitorizare include informaŃii despre activităŃile 
în curs de desfaşurare cât şi despre sarcinile care au fost deja realizate. 
 Această activitate de monitorizare de asemenea, vă permite să generaŃi rapoarte care arată 
managementul eforturilor dvs la orice moment de timp.Prin afişarea statusului proiectului puteŃi opta 
astfel pentru prelungirea deadline-ului,aducerea mai multor resurse, sau o schimbare în strategie ,în 
cazul în care lucrurile nu se întâmplă aşa cum v-aŃi fi aşteptat. 
 Figura 1.11 arată vizualizarea Tracking Gantt folosind tabelul implicit , Tabelul de 
monitorizare 
 Capitolul 12 explică anumite măsuri pentru actualizarea unui proiect , pentru a reflecta  
progresul real. 



 
 Figura 1.11: Utilizarea urmaririi Gantt cu scopul de a afisa stadiul proiectului. 
 
 
1.3 Efectuarea ajustărilor 
 
Monitorizarea nu este ceva care se lasă la finalul proiectului, sau la sfârşitul sarcinilor 
individuale.Monitorizarea sarcinilor în curs de desfaşurare, în mod regulat, vă ajută să detectaŃi orice 
abatere de la estimările făcute.Cu cât mai devreme descoperiŃi o întarziere cu atât ai timp mai mult 
alocat acelei întârzieri. 
 Dacă proiectul stabileşte că sunteŃi în întârziere cu o sarcină, el mută în mod automat 
sarcina dependentă în viitor. Ca de exemplu să presupunem că aŃi estimat durata unei sarcini la 3 zile. 
Cu toate acestea, aŃi pus deja patru zile de muncă pentru ea, şi nu este înca terminată. Proiectul pe langă 
faptul că te avertizează ca eşti în întârziere,el de asemenea, mută în viitor sarcinile care depind de acest 
lucru mai departe în plan. Proiectul de asemenea, prezintă conflictele de resursă , pentru a pune în lucru 
mai multe decât era estimat în vizionarea de resurse, cum ar fi Fişa de Resurse şi vizualizarea Fişei de 
Resurse Grafice. 
 Proiectul vă ajustează costul proiectului aşa cum aŃi urmărit, pentru a reflecta efectul "mai 
mare decât costurile aşteptate". Proiectul de asemenea, arată ca efect costuri neprevăzute pe bugetul 
total. În cazul în care costurile pe care le-aŃi urmărit sunt mai mari decât cele anticipate, proiectul 
afişează costurile totale, bazat pe o combinaŃie de costuri reale, şi estimările rămase. 
 Proiectul vă arată exact cât de mult din bugetul dvs aŃi folosit şi cât a mai rămas din buget , 
aşa că puteŃi să vă revizuiŃi alocări de resurse pentru a vă încadra în bugetul global pe care îl aveŃi 
alocat. 
 



   
2. Utilizarea liniilor de bază 
  
AveŃi finalizată faza de planificare a proiectului dumneavoastră prin stabilirea unei linii de bază. AŃi 
intâlnit acest termen în capitolele anterioare, dar o să înŃelegi semnificaŃia în procesul de monitorizare. 

  
2.1 Ce este o linie de bază? 
 
O linie de bază este o imagine al proiectului, atunci când aŃi terminat faza de planificare, sau uneori la 
sfârşitul unei faze critice. Linia de bază este un set de date care este stocat în acelaşi dosar în care puteŃi 
să urmăriŃi progresul real a datelor. Proiectul vă permite să salvaŃi pâna la 11 linii de bază şi pâna la 10 
planuri interimare în timpul proiectului. Se poate afişa o gamă largă de informaŃii despre linia de bază 
(e) dacă doriŃi, sau aveŃi opŃiunea de a nu afisa aceste informaŃii. Unele proiecte, în special cele mai 
scurte care se executa numai câteva săptămâni sau chiar câteva luni,poate avea o singura linie de bază 
de la bun început şi poate continua destul de aproape la estimările pe care le poate rula pe cursul 
aceluiaşi linii. 
 Alte proiecte, mai ales cele mai lungi, necesită stabilirea câtorva linii de bază, în special în 
cazul în care estimarea originală este complet diferită de ceea ce relevă proiectul iniŃial,aşa că estimarea 
iniŃiala nu ne mai este de folos.  
 PuteŃi modifica întreaga linie de bază, dacă sunt schimbări drastice şi apar încă de la 
începutul proiectului, sau se poate modifica linia de bază de estimare de la un anumit punct particular 
din proiect.  
 De exemplu, dacă proiectul dumneavoastră stationează la scurt timp după ce aŃi terminat 
programul şi tu defapt, începi munca trei luni mai târziu decât v-aŃi planificat, ideal ar fi să se 
stabilească un nou program de bază înainte de a începe proiectul. 
 Dacă, totuşi, lucraŃi de şase luni la proiect şi este pus pe "hold"(staŃionare) pentru o 
perioadă de trei luni, este posibil să doriŃi să modificaŃi calendarul viitoarelor sarcini şi a reseta iniŃial 
doar pentru sarcinile din viitor, pentru a vă ajuta de a evalua cu exactitate estimarea cât mai corecta a 
duratei proiectului. 
 Costurile pot schimba unei linii de bază, de asemenea. De exemplu, ce spuneŃi dacă salvaŃi 
o linie de bază, pentru care este stabilit 50000 dolari şi, înainte de a începe să lucraŃi, compania 
dumneavoastră limiteaza bugetul la 35,0000 dolari?  
  Indicat ar fi să modificaŃi resursele şi costurile şi abia apoi să resetezi linia de bază. Setarea 
interimară a liniilor de bază păstrează proiectele dvs de la modificările dese de estimări în cazul în care 
atenuarea circumstanŃelor sunt luate în calcul. 

  
 

2.2 Stabilirea unei linii de bază 
 
Începând cu Project 2002, Planning Wizard-ul nu mai apare atunci cand iŃi salvezi proiectul. În cele 
mai multe cazuri, este nevoie să salvezi un proiect de mai multe ori in timpul fazei de planificare, fara a 
salva linia de bază. 
 Atunci cand sunteŃi gata, puteŃi utiliza dialogul Save Baseline pentru a salva pana la 11 linii 
de bază şi 10 planuri interimare pentru proiectul dumneavoastră. Fiecare linie de bază este o fotografie 
a proiectului dumneavoastră in momentul in care aŃi salvat-o, şi fiecare linie de bază pe care o salvaŃi 
include informaŃii despre activitati, resurse şi sarcini. Pentru activitati, Project salveaza durată, data de 



start şi de sfârşit, timpul de lucru, costul, şi costul pe timp. Pentru resurse, Project salvează munca, 
timpul de lucru, costul şi informatiile despre costul pe timp din linia de bază. Pentru sarcini, Project 
salveaza datele de inceput şi sfarşit, lucrul, timpul de lucru şi costurile timpului. 
 Când se salveaza planuri interimare, Project salvează un set de date de start şi final pentru a 
putea compara un plan intermediar sau cu un plan din linia de bază, asta vă ajuta sa fiŃi atenŃi la 
desfărşurarea proiectului sau la eventualele probleme care pot sa apară. Salvarea liniiei de bază şi a 
planurilor interimare vă ajută sa comparaŃi informaŃiile curente(găsite in zonele de început şi final) cu 
informaŃiile din linia de bază. DiferenŃa dintre cele două tipuri este regasita in cantitatea şi tipul de 
informaŃie pe care Project il salvează. 
 Pentru a continua setările atunci când salvaŃi o linie de bază se urmăresc următorii paşi: 
           1. Se alege Tools-> Tracking->Save Baseline pentru a deschide dialogul de Save Baseline 
prezentat in figura 11-2. 
           2. SetaŃi linia de bază pe care doriŃi să-l salvaŃi. 

 
Figura 11-2: Folositi acest dialog pentru a salva o linie de bază sau un plan intermediar 

 
3. Deschide lista cu linii de bază şi selectează pe cea care se doreşte să fie salvata. 
4. Apasă OK. 

 
 Atunci când salvaŃi o linie de bază pentru activitatile selectate, puteŃi alege sa introduceŃi 
toate rezumatele subactivitatilor in rezumatul activitatii părinte; acest lucru ajută la mentinerea exactă a 
informaŃiilor de bază, ca în figura 11-3. RelaŃia dintre activitatile din proiect şi cele selectate anterior 
deschiderii dialogului, determină efectul check-boxurilor. 
 



Figura 11-3: PoŃi controla comportamentul proiectelor atunci când combini informaŃiile din linia de bază pentru 
activitatile selectate. 

 
 
 De exemplu, să presupunem ca aveŃi un proiect setat ca în figura 11-4. Mai mult decât atât, 
să presupunem ca aŃi selectat activitatea 6, un copil al activitatii 1 şi părintele activitatilor 7 şi 8, înainte 
să deschideŃi dialogul de Save Baseline. Dacă aŃi selectat doar From subtasks into selected summary 

task(s), Project combină informaŃia din activitatile 7 şi 8 in activitatea 6. Dacă aŃi selectat doar To all 

summary tasks, Project combină informaŃiile din activitatea 6 fără a se Ńine seama de informaŃiile de 
bază reŃinute în activitatile 7 şi 8. Dacă se selectează ambele opŃiuni, Project combină informaŃiile din 
cele 3 activitati şi le introduce în informaŃiile activitatii 1. 
 Să pesupunem că doriŃi să actualizaŃi linia de bază pentru a reflecta modificările din proiect, 
cum ar fi activitati adăugate sau schimbări la activitatile existente, modificări care afectează costul sau 
planificarea task-ului. Se evidenŃiază task-urile adăugate sau modificate şi apoi se salvează. În dialogul 
Save Baseline (Figura 11-3) selectaŃi opŃiunea Selected tasks şi se selectează ambele opŃiuni din 
secŃiunea de Baseline. Proiectul va actualiza linia de bază pentru activitatile modificate şi apoi va 
schimba nivelurile de sumar, pentru a reflecta schimbarea. 



 
Figura 11-4: Fiii determină comportamentul combinării informaŃiilor din linia de bază. În această imagine 

activitatile 3 şi 6 sunt copiii activitatii 1 şi activitatea 6 este parintele activitatilor 7 şi 8. 
 
 
 

2.3 Schimbarea unei linii de bază 
 
De cele mai multe ori, nu doriŃi sa faceti schimbări la o linie de bază. Este un moment ingheŃat în timp, 
o inregistrare cu care iŃi poŃi compara progresul. Dacă schimbi o linie de bază în mod regulat, ii distrugi 
scopul. 
 Vor apărea momente în care, din motive strategice, va trebui să modifici linia de bază şi să 
o resalvezi sau să salvezi o a doua sau a treia linie pentru a face faŃa modificărilor majore din proiect. 
Cu toate acestea, dacă modificările faŃa de linia de bază originala sunt obligatorii, trebuie să faci acest 
lucru într-un mod inteligibil şi eficient. În această sectiune se discuta despre câteva din momentele în 
care schimbările unei linii de bază sunt necesare şi se explică modul în care putem face aceste 
schimbări. 
 
 
2.3.1 Adăugarea unei activităŃi la o linie de bază 
 
Este destul de intâlnit cazul în care se creează linia de bază a unui plan şi după se realizează că s-a omis 
un pas, sau se decide spargerea unui pas in două etape.  
 Poate că la compania dumneavoastră se introduce o nouă cerinŃă sau proces, şi trebuie să se 
modifice o activitate pentru a se putea face faŃă schimbării. Nu se doreşte resetarea întregii linii de bază 
a proiectului, dar doreşti să salvezi acea activitate împreună cu linia de bază originala. Se poate face 
această schimbare după salvarea liniei de bază originala. 
 Pentru a adauga o activitate la linia de bază originala, în aşa fel incât să puteŃi urmări 
progresul, urmariŃi următorii paşi: 
 



 
1. FaceŃi una din urmatoarele: 

� Pentru a adauga o activitate noua la program şi a o introduce în linia de bază, întâi se adaugă 
activitatea în coloana Task Name din Gantt Chart şi apoi se selectează activitatea. 

� Pentru a se salva modificările la o activitate existenta, mai întai se fac modificările iar apoi 
se selectează activitatea. 

       2.     AlegeŃi Tools->Tacking->Save Baseline. Apare dialogul Save Baseline. 
       3.     SelectaŃi linia de bază pe care doriŃi să o modificaŃi din lista de Save Baseline. 
       4.     AlegeŃi opŃiunea din grupul Selected tasks, ca în Figura 11-5. 
 

Figura 11-5: FaceŃi modificări statelor şi salvaŃile într-o linie de bază deja existent. 
 
 

       5.     AlegeŃi opŃiunea de Roll up potrivită din setările liniei de bază ( vezi secŃiunea anterioară 
pentru detalii) 
       6.     Se apasă OK pentru a se salva linia de bază, care conŃine acum activitatea noua. 
 
 Se pot adăuga activitati liniei de bază prin introducerea lor in tabela Gantt, utilizând 
coloane precum Baseline Duration, Baseline Start or Finish. Cu toate acestea, adăugarea informaŃiilor 
liniei de bază in acest mod nu porneşte toate calculele liniei. De exemplu, adăugarea unei activitati la 
sfarşitul unui proiect prin această metodă nu afectează data de final a liniei de bază. 
 

 
3. Utilizarea planurilor interimare 
 
Se poate folosi linia de bază in diferite moduri. Se poate folosi ca un punct de referinŃă original şi 
pentru a se compara cu rezultatul actual la finalul proiectului pentru a se observa cat de bună a fost 
planificarea iniŃială, şi la viitoarele planificări să se Ńina cont de experienŃa anterioară. Linia de bază are 
de asemenea o importanŃă practica în timpul proiectului: atenŃionează momentul in care apar schimbări 
pentru a le putea integra mai uşor. Al doilea motiv, ar putea atenŃiona momentul în care să se salveze 
planurile interimare. 
 Basline-ul iniŃial poate avea mai degrabă interes istoric decat practic.. Linia de bază 
originala nu trebuie schimbata pentru că acea copie, planificarea iniŃiala, este importantă de reŃinut. Cu 



toate acestea, dacă calendarul se modifică dramatic faŃa de planificarea iniŃială, toate avertizările pe 
care Proiectul le dă devin inutile. Un proiect care incepe cu 6 luni mai târziu decat era stabilit, va 
avertiza fiecare activitate ca fiind în întarziere şi critic. Pentru a avea informaŃii folositoare despre 
proiect, este nevoie să se revizuiască programarea temporală pentru a reflecta realitatea. Doar salvând 
planuri interimare se poate observa cât de bine se respectă obiectivele revizuite. 
 AmintiŃi-vă că planurile intemediare conŃin informaŃii pe care puteŃi sa le comparaŃi cu alte 
planuri interimare sau cu o linie de bază, acest lucru ajutând la monitorizarea desfărşurării planului şi 
diferenŃele ce pot să apară. O linie de bază include mult mai multe informaŃii – durată, data de început 
şi de sfârşit, munca, costul şi informaŃiile despre activităŃi, resurse şi asignări. Salvarea liniilor de bază 
şi a planurilor interimare ajută la compararea informaŃiilor curente, găsite în câmpurile de inceput şi 
sfârşit, cu informaŃia din linia de bază, gasită în acele câmpuri. 
 AveŃi posibilitatea să setaŃi planuri interimare pentru toate activitaŃile din proiect. Cu toate 
acestea ar trebui să se salveze un plan intermediar doar pentru activitatile care merg mai departe. De 
exemplu, dacă apare o grevă care întarzie proiectul cu 2 luni, ar trebui să se pastreze linia de bază 
intacta pentru toate activitatile care erau terminate la începutul grevei şi salvarea planului intermediar 
pentru toate activitatile care trebuiesc terminate după ce greva se termină. 
 De asemenea se pot utiliza planurile interimare pentru a copia informaŃia dintr-o linie de 
bază în alta.  
 
Pentru a salva un plan intermediar, trebuie să: 
 

� SelectaŃi diferite sarcini pe care vreŃi să le introduceŃi în planul intermediar. 
� SelectaŃi Tools->Tracking->Save Baseline pentru a deschide fereastra de dialog Save Baseline. 
� SelectaŃi opŃiunea Save interim plan. Proiectul va face câmpurile Copy şi Into disponibile. 
� FaceŃi clic pe săgeata din dreptul câmpului Copy pentru a afişa lista derulantă.  

Figura 11-6 arată faptul ca s-a deschis lista Into, care conŃine aceleaşi  
opŃiuni care se găsesc în lista Copy. 
 
 



 
Figura 11-6. OpŃiunile din listele Copy şi Into permit salvarea mai multor seturi 

 de date de Start şi Finish în planul intermediar. 
 

 
� SelectaŃi Start / Finish din lista derulantă Copy pentru a copia datele curente de început şi 

sfârşit. 
� DeschideŃi lista derulantă pentru câmpul Into şi selectaŃi elemental numerotat, cum ar fi  

Start1/Finish1, pentru a copia datele în noile câmpuri, creând astfel un plan intermediar. 
� SelectaŃi butonul Entire project option pentru a crea un plan intermediar pentru întregul proiect, 

sau selectaŃi butonul Selected tasks option pentru a crea un plan intermediar care îşi păstrează 
informaŃia originală pentru toate sarcinile neselectate, şi salvează o nouă informaŃie iniŃială 
pentru sarcinile selectate. 

� FaceŃi clic pe OK pentru a salva planul iniŃial intermediar. 
 

Se pot utiliza diferite elemente de Start / Finish pentru a salva până la 10 planuri interimare plus 
originalul, pentru un total de 11 planuri interimare peste durata de viaŃă a proiectului. 

 
 
 
3.1 Ştergerea unui plan de bază sau intermediar 
 
În mod inevitabil, mai întai trebuie să seteze o linie de bază sau o linie de bază intermediara şi apoi să 
se găsească un motiv pentru a-l şterge. Să presupunem, de exemplu, că aŃi crezut că aŃi terminat stadiul 
de planificare al proiectului. Proiectul nu a început încă, şi vreŃi să stabiliŃi o şedinŃă, în care să îi 
informaŃi pe toŃi că sunteŃi "good to go", pentru următoarea zi de luni. BineînŃeles, acest anunŃ 
declanşează discuŃii şi - de la data la care se termina discuŃia – scopul proiectului s-a extins (sau s-a 
micşorat) considerabil. Acum trebuie sa lucraŃi din nou la faza de planificare a proiectului - şi chiar nu 



doriŃi să modificaŃi planul iniŃial. În schimb, vreŃi să scăpaŃi de ea; după ce faceŃi toate aceste 
modificări, aveŃi posibilitatea să setaŃi corect planul iniŃial. 

 
Începând cu Project 2000, se poate şterge o linie de bază. Se alege Tools->Tracking->Clear Baseline. 
MS Project afişează fereastra de dialog Clear Baseline, ca în Figura 11-7. În această fereastraă de 
dialog, există posibilitatea de a alege ştergerea unei linii de bază sau a unui plan intermediar pentru 
întregul proiect sau pentru anumite sarcini selectate. 
 
  

 
Figura 11-7: AŃi setat un plan de bază prea devreme? Puteti şterge din  
această fereastraă de dialog, astfel încât să puteŃi face modificările şi  

să setaŃi planul de bază corect. 
 
 
 

4. Vizualizarea progresului cu Tracking Gantt View 
 
Planul de bază ajută la vizualizarea diferenŃelor dintre estimările pe care le-aŃi facut faŃa de activitatea 
la momentul actual în cadrul proiectului.  

MS Project vă permite să vedeŃi această diferenŃă atât grafic, cu planul iniŃial şi bara de 
sarcini actuale, precum şi prin informaŃiile care sunt afişate în tabele in diferite vizualizări. Următoarea 
secŃiune explică modul în care se poate afişa planul iniŃial şi datele actuale, precum şi modul cum se 
poate utiliza această caracteristică pentru a înŃelege statutul proiectului. 

 
4.1 Interpretarea Tracking Gantt View 
 
 
Tracking Gantt View este folositor in vizualizarea progreselor comparativ estimărilor facute în planul 
de bază iniŃial. Pentru a deschide Tracking Gantt View, faceŃi click pe icoana sa în bara View sau 
alegeŃi View->Tracking Gantt. Această vizualizare arată tabelul Entry in mod implicit. Cu toate 
acestea, se pot adăuga sau elimina câmpuri (coloane), sau se pot afişa alte tabele de informaŃii. 
Coloanele care sunt prezentate în Figura 11-8 includ informaŃiile de bază care au fost adăugate in 
tabelul Tracking (de monitorizare). 
 



 
Figura 11-8: Tabelul Tracking Gantt poate afişa o multitudine de informaŃii. 

 
 
 
Ca idee, câmpurile Baseline Duration şi Baseline Cost care au fost adăugate în tabel, precum şi 
câmpurile Actual Duration şi Actual Cost care apar în tabelul Tracking Gantt in mod implicit. Aceste 
câmpuri ajuta compararea estimărilor faŃă de sincronizarea şi costul actual. 
 
PuteŃi modifica acest tabel, astfel încât coloana Baseline Duration este alături de coloana Actual 
Duration, iar coloana Baseline Cost este alături de coloana Actual Cost.  
 
Implicit tabelul Tracking Gantt conŃine, de asemenea, următoarele informaŃii: 
 

2. % Complete: Acest câmp arată evoluŃia diverselor sarcini în program.  
Figura 11-9 arată că o sarcină este completă. 

3. Physical % Complete: Un câmp pe care îl puteŃi utiliza pentru a calcula BCWP (costul de 
muncă alocat). Proiect calculeaza câmpul % Complete pentru proiect, bazându-se pe valorile 
introduse in Total Duration sau Actual Duration, dar se poate introduce o valoare pentru câmpul 
Physical % Complete. Se poate folosi acest câmp, pentru a calcula BCWP atunci când valoarea 
% Complete nu ar reprezenta cu acurateŃe munca reala depusă pentru a realiza o sarcină. Prin 
urmare, % Complete se referă la durată iar Physical % Complete la volumul de lucru şi efort. 

4. Durata Rămasă: Acest câmp reflectă durata de timp necesară pentru a finaliza o sarcină 
neterminată. AveŃi posibilitatea să introduceŃi o valoare în acest câmp, sau vă puteŃi lasa 



programul pentru a sa o calculeze prin introducerea unei valori in unul din câmpurile Actual 
Duration sau % Complete. Dacă introduceŃi o valoare pentru Durata Rămasă, programul 
calculează o valoare nouă % Complete şi o nouă valoare Durata; Programul modifică valoarea 
Durata ca fiind suma intre Actual Duration Durata şi Durata Rămasă, neinteresându-ne Actual 
Duration. 

5. Lucrul real: câmpul Actual Work, volumul de lucru care a fost efectuat de resurse. Există 
câmpuri Actual Work pentru sarcini, resurse, precum şi misiuni, precum şi câmpuri Actual 
Work pe etape de lucru pentru sarcini, resurse şi misiuni. 

 

 

De asemenea, puteŃi afişa bare pentru sarcini prin manipularea compasului între tabel şi graficul 
de domenii pentru a avea o vizualizare grafica a progreselor proiectului. Figura 11-9 afişează 
vizualizarea Tracking Gantt cu tabelul Schedule. Tracking Gantt afişează diferite stiluri de bare sarcină 
pentru a indica progrese cu privire la activităŃile din cadrul proiectului. În partea de sus a Gantt Chart, 
veŃi vedea rezumatul de sarcini pentru proiect, şi mai jos, veŃi vedea o bara hasurata cu alb-negru. 
Această bară reprezintă progrese cu privire la rezumatul sarcină. Sarcinile noncritice sunt prezentate în 
albastru, şi sarcinile critice sunt în roşu. 
 

Pe toate sarcinile care nu sunt rezumat sarcini, veŃi vedea două bare; bara de sus reprezintă 
durata de aşteptat, şi în partea de jos bara reprezintă durata iniŃială. 
 

Procentul indicator la marginea unei sarcini reflectă procentajul terminat pentru acea sarcină. 
Barele din partea de sus a sarcinilor realizate, cum ar fi sarcina Dig the hole, sunt solide în culoare, în 
timp ce barele din partea de sus a sarcinilor incomplete, cum ar fi sarcina Build the deck, sunt 
reprezintate cu un model şi apar în culoare deschisă. Barele sarcinilor parŃial completate, cum ar fi 
sarcina Pour the pool, sunt solide pe stânga şi reprezentate cu un model in partea dreaptă.  
 

PuteŃi, de asemenea, spune pe scurt, dacă o sarcină este realizată mai devreme sau mai târziu 
decât s-a estimat. PriviŃi sarcina Dig the hole; bara de sus (durata actuală) este mai scurtă decât în 
partea de jos bar (durata de bază). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Procent complet  

 
Rezumat al progresului  

 
 

 
 
 
                        

   Sarcină în curs de desfăşurare 
 

Baseline  
 
Figura 11.9: Diverse bare de sarcini arată progresele şi diferentele proiectului. 

 
 
4.2 Tabelul Task Variance 
 
După cum se schimbau tabele care sunt afişate în Tracking Gantt view, se văd diferite informaŃii despre 
progresele realizate în cadrul proiectului. Tabelul Variance, de exemplu, scoate în evidenŃă variaŃia 
timpului unei sarcini intre cel iniŃial şi cel curent.  

Pentru a afişa acest tabel, aratat în figura 11-10, faceŃi clic-dreapta pe butonul Select All în 
colŃul stânga-sus al tabelului la intersecŃia liniei care conŃine poziŃia coloanei şi a coloanei care conŃine 



numarul sarcinii. SelectaŃi Variance din lista de tabele care apare. 
PuteŃi compara uşor Baseline Start şi Baseline Finish şi coloanele efective de Start şi 

Finish, care arată date reale pentru sarcinile cărora le-aŃi urmarit progresul, precum şi datele de bază 
pentru activităŃi cu nici un progres. Acest tabel conŃine, de asemenea,câmpuri pentru a vă arăta Start 
Variance (câte zile mai târziu sau mai devreme a pornit o sarcină) şi Finish Variance (câte zile mai 
târziu sau mai devreme s-a încheiat o sarcină). 
 

 

 
Figura 11-10: Dacă vă aflaŃi în urmă cu programul, puteŃi vedea groaznicul 

adevăr în Tabelul de VariaŃie. 
 
 

4.3 Tabelul Task Cost 
 
Tabelul Task Cost este cel mai util pentru sublinierea variaŃilor sumelor de banii cheltuiŃi pe parcursul 
proiectului. Figura 11-11 arată un tabel Task Cost pentru un proiect în curs de desfăşurare, cu unele 
costuri suportate şi altele care urmează a fi expandate. În acest moment, sarcina Pour the pool 
depaşeşte costul estimat cu 400 dolari. Proiectul ia în considerare următorii factori în calcularea 
costului variaŃiilor: 
 

• Timp real lucrat al resurselor. 
• Estimarea zilelor de resursă timp de la momentul actual în continuare care trebuie expandat 

pentru a finaliza sarcina. 
• Costurile reale (cum ar fi taxele şi permisele), care au fost urmărite pentru o sarcină. 

 
 
 
 



 
Figura 11-11: Tabelul Task Cost indică locurile in care aŃi cheltuit prea mult şi locurile  

în care mai este necesara cheltuirea unei sume suplimentare. 
 

 
Comparativ cu o estimare iniŃială de 1600.00 dolari, sarcina Pour the pool a depaşit bugetul. 
 
 
4.4 Tabelul Task Work 
 
Tabelul Task Work al vederii Tracking Grantt, aşa cum se arată în Figura 11-12, se concentrează pe 
numărul orelor de lucru adus de resursele care sunt implicate în activităŃile sarcinilor. De exemplu, 
lucrul Baseline pentru sarcina Pour the pool a fost de 64 ore. Cu toate acestea, sarcina este doar parŃial 
completată şi a luat 94 de ore. Prin urmare, domeniul de variaŃie, Variance, (diferenŃa dintre orele de 
muncă iniŃiale şi ore petrecute în realitate) arată o pierdere de 30 de ore. Pe de altă parte, în estimarea 
Baseline pentru sarcina Dig the hole au fost de 32 de ore, iar sarcina a fost finalizată în 30 de ore. 
Coloana de variaŃie, Variance, arată o economie de 2 ore; valoarea negativă indică faptul că au fost 
folosite mai puŃine ore decât au fost estimate iniŃial. 
 VeŃi vedea mai multe tabele de acest tip şi mai multe vizualizări de monitorizare în 
următoarele câteva capitole. În acest punct, ar trebui să aveŃi cunoştinŃe fundamentate asura tipurilor de 
informaŃii pe care le puteŃi obŃine prin monitorizarea progreselor proiectului dumneavoastră. 
 
 
 



 
Figura 11-12: Pentru a determina dacă o sarcină necesită mult mai mult 

efort decât aŃi estimat, verificaŃi tabelul Task Work. 
 

 
 

5. ÎnŃelegerea strategiei de monitorizare 
 
Pe măsură ce utilizaŃi Microsoft Project pentru proiecte reale, vă veŃi îmbunătăŃi abilităŃile de 
monitorizare. Cu toate acestea, dacă urmaŃi anumite principii de monitorizare de bază de la început, 
puteŃi scapa de multe necazuri, în primele proiecte. 
 
 
5.1 Abordarea activităŃii de monitorizare 
 
În primul rând, actualizaŃi programul proiectului în mod frecvent şi la intervale regulate. MulŃi oameni 
văd monitorizarea ca o sarcină monumentala: Toate detaliile progresului şi duratei pentru fiecare 
sarcină, precum şi toate resursele şi costurile care sunt asociate fiecarei sarcini, trebuie să fie înscrise 
una câte una. 

Trebuie să adunaŃi aceste date prin intermediul resurselor de tip timecards, raportate din 
partea altor participanŃi la proiect, şi de furnizorul de facturi. Trebuie să înregistraŃi toate informaŃiile 
pe care le adunaŃi. Nu trebuie sa luaŃi în glumă monitorizarea, pentru ca poate fi un lucru greu. Cu toate 
acestea, cu cât mai des să urmăriŃi, cu atât mai puŃin se vor aduna date de monitorizare, şi mai puŃin 
probabil este ca acestea să vă copleşească. 

Ajuta-te cu sarcina de monitorizare prin atribuirea părŃilor de actualizare diferitelor 
persoane în proiectul dumneavoastra. Dacă o anumită resursă este responsabilă de o fază a proiectului, 
el sau ea va avea de urmărit doar activităŃile din acea fază. PuteŃi folosi diferite metode de a elabora 
programe mai mici, într-un program general. 
 



Dacă aveŃi o resursă disponibilă, cum ar fi de exemplu un asistent administrativ care poate rezolva 
monitorizarea detaliilor - cu atât mai bine. AsiguraŃi-vă că furnizaŃi acestui asistent o formare 
profesională adecvată (şi o copie a acestei cărŃi), astfel încât el sau ea sa înŃeleagă procesul de 
monitorizare suficient de bine pentru a fi la obiect şi productivi. Oricum, aceste resurse, probabil, nu 
trebuie să fie experŃi în lucru cu Project pentru a prelua parte din muncă.  
 Pentru a vă ajuta să vă amintiŃi să urmări, introduceŃi monitorizarea ca o sarcină recurentă, 
care are loc o dată pe săptămână sau o dată la două săptămâni, în cadrul fişierului proiectului 
dumneavoastra. Şi nu uitaŃi să includeŃi întâlniri necesare (cum ar fi întâlniri de raportare a progresului 
şi revizuirea performanŃelor) în program. 
 

5.2 Monitorizarea monitorizării 
 

Utilizarea notelor de sarcină pentru a înregistra progresele şi schimbările, poate fi o altă strategie 
eficientă de monitorizare. Dacă se produce o schimbare importantă pentru care nu merită să schimbaŃi 
linia dumneavoastră de bază, utilizaŃi note sarcină care să le înregistreze. Când ajungeŃi la sfârşitul 
proiectului, aceste note vă ajută să documentaŃi şi sa justificaŃi tot, de la termenele ratate la depăşiri de 
cost. 

ÎncercaŃi să stabiliŃi unele standarde pentru monitorizare în organizaŃia dumneavoastră. De 
exemplu, cum ai determina momentul în care o sarcină este completă? Cum măsuraŃi costurile, şi care 
este sursa de informaŃii cu privire la timpul petrecut de resurse pentru o sarcină? Proiectul devine un 
instrument de management mult mai eficace, dacă fiecare manager de proiect utilizează metode 
identice de măsurare a progreselor şi a cheltuielilor, la fel cum departamentul de contabilitate a firmei 
dumeavoastră foloseşte standarde de monitorizare a costurilor. 
Setarea liniilor de bază multiple, este utilă, dar cum decideŃi când să salvaŃi fiecare iteraŃie?  
Este posibil să doriŃi să luaŃi în considerare o alta linie de bază pentru fiecare etapă majoră din proiectul 
dumneavoastră. Chiar şi proiecte de dimensiuni mari, de obicei, au numai patru sau cinci etape majore 
semnificative, şi este probabil ca acestea să apară după ce aŃi realizat o parte mare din proiect. 
 

6. Concluzii 
 
Acest capitol explorează unele dintre conceptele fundamentale ale activităŃii de monitorizare pentru un  
proiect. Ai devenit familiar cu următoarele:  
 

• Cum stabiliŃi, modificaŃi şi ştergeŃi liniile de bază. 
• Cum vizualizaŃi estimările iniŃiale comparativ cu progresul real 

 
 



Aplicaţii 

 

 

1. Care este diferenţa dintre o linie de bază (baseline) şi un plan interimar (interim plan)? 

 

 

2. Care este diferenţa dintre câmpurile % Complete şi Physical % Complete? 

 

 

3. În proiectul Meeting.mpp introduceţi duratele şi constrângerile corespunzătoare activităţilor, 

precum şi resursele necesare. Din echipa care pregăteşte întâlnirea fac parte două persoane cu 

normă întreagă şi una cu normă part-time (deci unele activităţi se pot desfăşura în paralel, dacă are 

sens acest lucru în logica acţiunilor). 

 

 

4. Salvaţi o linie de bază a proiectului. 

 

 

5. Vizualizaţi diagrama Gantt de monitorizare (Tracking Gantt) cu următorul cap de tabel: 

 

 
 

 

6. Se amână cu o săptămână toate activităţile din Meeting Packets (documentele necesare pentru 

discuţie) şi Speakers. Reflectaţi această schimbare în proiect. 

 

 

7. Atribuiţi diferite stadii de completare activităţilor şi vizualizaţi-le în contrast cu linia de bază 

salvată. 

 




